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File Listing

	Task
	Exercise
	Recommended Method
	Student Data File
	Solution File

	Insert a Table
	13-1
	Click the Insert Table button on the Standard toolbar. Drag the pointer down and define the number or rows and columns in the table. 
	Briefing.ppt
	None

	Navigate in a Table
	13-2
	Click any table cell. Press [Tab] several times to move the insertion point through cells from left to right. Press [Shift]+[Tab] several times to move the insertion point through cells from right to left. Press each arrow key several times and observe the movement of the insertion point.
	None
	None

	Draw a Table Using the Pencil Pointer
	13-3
	Click the Tables and Borders button on the Standard toolbar. Click the Draw Table button on the Tables and Borders toolbar. Use the pencil pointer to create a rectangle. Draw horizontal lines all the way across the table to create rows. Split the table using four vertical lines extending from the first horizontal line to the bottom of the table.
	None
	None

	Select Groups of Cells and Text
	13-4
	Select a single cell in the table by clicking it. Move the pointer outside the table border above a column and click when the pointer changes to a small, black, down-facing arrow. This will select the column. To select a range of cells, click the starting cell in a selection; then hold down [Shift] and click the ending cell.
	None 
	None

	Select an Entire Table
	13-5
	Right-click any cell in the table and choose Select Table from the shortcut menu.
	None 
	None

	Insert and Delete Rows and Columns
	13-6
	Right-click the selected column in the table and choose Insert Columns from the shortcut menu. Click Table on the Tables and Borders toolbar and choose Insert Columns to the Right. Click Table on the Tables and Borders toolbar and choose Delete Columns. 
	None 
	Sol13-6.ppt

	Split Cells
	13-7
	Click the cell containing the text and click the Split Cell button on the Tables and Borders toolbar.
	None 
	None

	Merge Cells
	13-8
	Select the cells that have to be merged. Click the Merge Cells button on the Tables and Borders toolbar.
	None 
	None

	Use the Pencil to Split a Cell Diagonally
	13-9
	Click the Draw Table button to change the pointer to a pencil. Use the pencil tool to draw a diagonal line across the cell to the upper-right corner. Click the Draw Table button to turn off the pencil.
	None 
	Sol13-9.ppt

	Change the Height and Width of Rows, Columns, and Tables
	13-10
	Move the mouse pointer over the right border of a column. When the pointer changes to a vertical double-headed arrow, drag the column border and change its width. Move the mouse pointer to the bottom border of a row. When the pointer changes to a horizontal double-headed arrow, drag the border to change its height.
	None 
	None

	Distribute Columns and Rows Evenly
	13-11
	Select the columns. Click the Distribute Columns Evenly button on the Tables and Borders toolbar. Select the rows. Click the Distribute Rows Evenly button on the Tables and Borders toolbar.
	None
	None

	Resize a Table
	13-12
	Click anywhere inside the table to get the eight sizing handles around the border. Use the diagonal two-pointed arrow to drag the lower-right corner of the table down and to the right. Drag the middle-sizing handle on the bottom of the table up to create more rows.
	None
	Sol13-12.ppt

	Align Text and Numbers Horizontally
	13-13
	Click the Center button on the Formatting toolbar or press [Ctrl]+[E] to center-align the selected text or numbers. Click Align Right or press [Ctrl]+[R] to right-align text or numbers.
	None
	Sol1-13.ppt

	Change the Vertical Position of Text in a Cell
	13-14
	Click the Align Bottom button on the Tables and Borders toolbar. Click the Center Vertically button to move the text to the middle of the cells.
	None
	None

	Use Margin Settings to Adjust the Position of Text in a Cell
	13-15
	Select the cells to be formatted. From the Format menu, choose Table to open the Format Table dialog box. Click the Text Box tab. Notice that the Text alignment setting is already set to Middle. Click the Text alignment list box arrow to see the other settings. Choose Middle again. Under Internal margin, make relevant changes in the Right text box and click OK.
	None
	Sol13-15.ppt

	Add Fill Color to Table Cells
	13-16
	Select the cells to be formatted. Click the arrow for the Fill Color button on the Tables and Borders toolbar and choose the color.
	None
	None

	Remove a Fill Effect from a Cell
	13-17
	Select the cells that have the fill effect. Click the list box arrow for the Fill Color button and choose No Fill.
	None
	None

	Change the Color and Style of Table Borders
	13-18
	Select any cell in the table. Open the Border Style list on the Tables and Borders toolbar. Click the list box arrow for Border Style and choose the dash line. Then, click the list box arrow for Border Width and choose 1½ pt. Click the Border Color button and choose a color. Click Table on the Tables and Borders toolbar and choose Select Table from the menu. Click the list box arrow for the Borders button, and then click the Inside Borders button on the menu. With the table still selected, change the options on the Tables and Borders toolbar, so the Border Style is a solid line, the Border Width is 3 pt, and the Border Color is dark red. Click the list box arrow for the Borders.
	None
	Sol13-18.ppt

	Insert a Word Table
	13-19
	Without closing PowerPoint, start Word and open the file with the table. Click the table move handle to select the table. Copy the table to the clipboard. Switch to PowerPoint. From the Edit menu, choose Paste Special. In The Paste Special dialog box, choose Microsoft Office Word Document Object in the As list box. Click OK.
	Brief1.doc
	None

	Make Changes to a Word Table
	13-20
	Double-click the Word table in the PowerPoint slide to open the Word toolbars and menu. Make the changes and click outside the table border to return to PowerPoint.
	None 
	Sol13-20.ppt

	Create a table, key text, select parts of a table, change column width, and resize the table.
	13-21
	
	CookOff.ppt
	Sol13-21.ppt

	Create a table, apply border and fill options, and change cell alignment and text alignment.
	13-22
	
	Operate2.ppt
	Sol13-22.ppt

	Draw a table; insert and delete rows and columns; adjust column and row width; apply formatting for text, fill colors, and borders.
	13-23
	
	Operate3.ppt
	Sol13-23.ppt

	Import a Microsoft Word table, edit and format the Word table, format a PowerPoint table, and merge and split cells.
	13-24
	
	NewMenu1.ppt, NewMenu2.doc
	Sol13-24.ppt

	Create a presentation with a table slide, apply border settings, arrange and format text, and change column widths and table size.
	13-25
	
	Print1.ppt, Logo1.emf
	Sol13-25.ppt

	Edit and format a presentation; insert a table slide; insert rows; change row height, column width, alignment, and cell margins; and create hyperlinks for table text.
	13-26
	
	Ads2.ppt
	Sol13-26.ppt

	Edit and format a presentation including a table slide, add data, change alignment, change table colors, merge cells, and embed a Word table.
	13-27
	
	MktSum.ppt, AdBudget.doc
	Sol13-27.ppt

	
	13-28
	
	None
	None

	
	13-29
	
	None
	None

	
	13-30
	
	None
	None


The outline for this lesson will be presented in the following two sections:



Lecture Outline

· Highlights from the text

· Short discussions on difficult items

Lecture Notes

· Notes

· Teaching tips

· Text figures

· PowerPoint slides

Lesson Outline

Section 13.1

Creating a Table
This section focuses on:

· Inserting a Table

· Navigating in a Table

· Drawing a Table Using the Pencil Pointer

Section 13.2

Selecting a Table, Cells, and Text
This section focuses on:

· Selecting Groups of Cells and Text

· Selecting an Entire Table
Section 13.3

Modifying Table Structure
This section focuses on:

· Inserting and Deleting Rows and Columns

· Splitting Cells

· Merging Cells

· Using the Pencil to Split a Cell Diagonally

· Changing the Height and Width of Rows, Columns, and Tables

· Distributing Columns and Rows Evenly

· Resizing a Table
Section 13.4

Aligning Text and Numbers
This section focuses on:

· Aligning Text and Numbers Horizontally

· Changing the Vertical Position of Text in a Cell

· Using Margin Settings to Adjust the Position of Text in a Cell
Section 13.5

Applying Fill Colors and Borders
This section focuses on:
· Adding Fill Color to Table Cells

· Removing a Fill Effect from a Cell

· Changing the Color and Style of Table Borders

Section 13.6

Inserting a Microsoft Word Table
This section focuses on:
· Inserting a Word Table

· Making Changes to a Word Table

	Lecture Outline
	Lecture Notes

	Creating Effective Tables
Characteristics of a table:
· Tables display information organized in rows and columns.
· Table structure can be modified by adding columns or rows, and merging and splitting cells.
· Table content can be aligned in different ways for easy-to-read layouts.
· Color can be applied to highlight selected cells in a table or to add table borders.

Section 13.1
Creating a Table

To create a table in PowerPoint, users can apply one of the following methods:
· Insert a new slide, choose Text and Content layout, and click the table button.
· Choose the Insert Table button on the Standard toolbar.
· Choose the Table button on the Tables and Borders toolbar.
· Draw a table using the Draw table pen tool on the Tables and Borders toolbar.

Inserting a Table

A user can insert a table using the Insert Table button. When the Insert Table button is used, a table’s dimensions are defined by dragging the mouse pointer down and across a grid.
· The Automatic Layout Options smart tag button can be used to remove the automatic layout from the table.

· To move a table, point to the table’s border and use the four-pointed arrow.
Navigating in a Table

A table is composed of a series of rows and columns. The rectangle formed by the intersection of a row and a column is called a cell. There are many ways to navigate from cell to cell in a table:
· Click the cell.
· Use the Arrow keys.
· Press [Tab] to navigate forward or [Shift]+[Tab] to navigate backward in a table.
Drawing a Table Using the Pencil Pointer
To draw a table using the pencil pointer:
· Drag the pencil pointer diagonally down and across to create a rectangle that is the approximate size of the table’s outside border.
· Then, draw horizontal and vertical lines within the table to divide it into columns and rows.

	Lesson Key Objective

Create effective tables by modifying table structure and formatting the table content.
Additional Notes:

With each method of creating a table, you need to specify the number of columns and rows that you require.
Teaching Tip:

Explain the buttons on the Tables and Borders toolbar with the help of Table 13-1.
Text Figure: F13-1


[image: image1.emf]Insert a Table



[image: image2.emf]Navigate in a Table


Text Figure: F13-2

Text Figures F13-3, F13-4


	Section 13.2

Selecting a Table, Table Cells, and Text
To apply formatting features to table cells, the cells first need to be selected. A user can select:

· A single cell.
· A group of cells.
· An entire table.
Selecting Groups of Cells and Text
To select a cell or groups of cells and text, users need to:
· Select a single cell by clicking it.

· Select the column or row containing the active cell by choosing Table on the Tables and Borders toolbar and then choose Select Column or Select Row from the menu.

· Select a rectangular group of cells by clicking a corner cell and drag the mouse pointer diagonally to the other corner.

· Click the starting cell in a selection; then [Shift]+click the ending cell.

· When the table is not selected, move the pointer just outside the table border above a column and then click when the pointer changes to a small, black, down-facing arrow.
Selecting an Entire Table

The formatting of an entire table can be changed by selecting it. Users can apply the following methods to select an entire table:
· Select all the cells in the table by dragging diagonally across them.

· Click the table’s selection border, so that the border changes from small diagonal lines to small dots.

· Right-click the table and choose Select Table from the shortcut menu.

· When at least one table cell is activated or selected, press [Ctrl]+[A].

· When the table is not active, press [Tab] one or more times to cycle through all the objects on the slide until the table’s selection border is displayed.

	Additional Notes:
The Tables and Borders toolbar provides a Fill Color button, but not a Font Color button. Use the Font Color button on the Formatting or Drawing toolbar to change the text colors in a table.

[image: image3.emf]Select Groups of  Cells and Text


Teaching Tip:

Inform the students that when they are selecting a group of cells, to be careful that they are dragging the I-beam pointer and not the drag-and-drop arrow pointer. If they accidentally drag text to a new location, ask them to use the Undo command to correct the error.

Text Figure: F13-5

Teaching Tip:
Make sure students understand the importance of using the correct mouse pointer for various operations.


[image: image4.emf]Select an Entire  Table



	Section 13.3

Modifying Table Structure

A table structure can be modified by:
· Inserting or deleting columns.
· Merging a group of cells.
· Splitting an individual cell into two cells.
Inserting and Deleting Rows and Columns
There are two ways to select cells while inserting or deleting columns. A different menu is used depending on the way the cells are selected.
· If an entire column is selected, right-click the column and use commands on the shortcut menu.

· If one or more cells are selected in a column, click Table on the Tables and Borders toolbar, and choose a command from its menu.

Columns can be inserted either to the right or to the left of the column that contains the active cell. The column formatting of the active column is copied to the new column.
Splitting Cells

Cells can be split by:
· Drawing a line through them with the pencil pointer.
· Using the Split Cell button on the Tables and Borders toolbar.
· Clicking Table and choosing Split Cell from the menu.
Merging Cells

To merge cells, users can use one of the following methods:
· Use the Eraser button on the Tables and Borders toolbar to remove a border between two adjacent cells.
· Select two or more cells and then click the Merge Cells button on the Tables and Borders toolbar.
· Select two or more cells, right-click the selection, and choose Merge Cells from the shortcut menu.
Using the Pencil to Split a Cell Diagonally

Splitting a cell using the pencil does not create two separate cells, but merely draws a line within one cell.

Changing the Height and Width of Rows, Columns, and Tables

· A table can be made smaller or larger by dragging its sizing handles.

· The height of rows and the width of columns can be changed individually by dragging cell borders.

Distributing Columns and Rows Evenly

· The Distribute Columns Evenly button on the Tables and Borders toolbar can be used to easily adjust several columns to be the same width.

· The Distribute Rows Evenly button on the Tables and Borders toolbar can be used to adjust several rows to be the same height.

Resizing a Table

· To resize the entire table, users can drag one of the sizing handles.
· Hold down [Shift] while dragging a corner-sizing handle, to resize a table proportionately. 

	Text Figures: F13-6, F13-7
Teaching Tip:
Inform students that they can also insert a row at the bottom of the table by pressing [Tab] if they are in the last cell of the last table row.

[image: image5.emf]Insert and Delete  Rows and Columns


Text Figure: F13-8
Additional Notes:

When the Split Cell button is used, the cell may not split the way you want it to, and may split horizontally when you want to split it vertically. Users can use the pencil pointer to control which way the cell splits.

Text Figures: F13-6, F13-9

[image: image6.emf]Use the Pencil to  Split a Cell Diagonally


Teaching Tip:

Explain that splitting a cell diagonally is only a simulation. After you create a diagonal line across a cell, you still have only one cell. Using [Enter] and alignment creates the look of two cells split diagonally.

Text Figure: F13-10

Text Figures: F13-6, F13-11



	Section 13.4

Aligning Text and Numbers

A user can specify whether text or numbers should appear at the top, middle, or bottom of a cell, and be horizontally left-, center-, or right-aligned. Cell margin settings can be used to further refine the position of text and numbers in a cell. A cell margin is the space between the text in a cell and its borders.
Aligning Text and Numbers Horizontally
The buttons on the Formatting toolbar used to align text and numbers horizontally are:
· Align Left

· Center
· Align Right

· Justify

Changing the Vertical Position of Text in a Cell

The buttons on the Tables and Borders toolbar used to change the vertical position of text in a cell are:
· Align Bottom

· Center Vertically

Using Margin Settings to Adjust the Position of Text in a Cell

A cell’s margin settings can be used along with horizontal and vertical alignment to determine where text is placed in a cell.

	Teaching Tip:

Discuss the various keyboard shortcuts for aligning text.
Text Figures: F13-12, F13-13


[image: image7.emf]Use Margin Settings  to Adjust the Position of Text in a Cell



	Section 13.5

Applying Fill Colors and Borders

The buttons on the Tables and Borders toolbar are used to apply formatting such as fill effects and borders to selected cells of a table or the entire table.


Adding Fill Color to Table Cells

A fill color or other fill effects such as patterns, gradients, or picture effects, can be applied to one or more cells in the table.

Removing a Fill Effect from a Cell
Users need to click the No Fill option in the list box arrow for the Fill Color button to remove a Fill Effect from a cell.
Changing the Color and Style of Table Borders

Table borders are the lines forming the edges of cells, columns, rows, and the outline of the table. The Borders button’s drop-down list enables you to apply borders to all the cells in a selection, to only an outside border, or to only the inside borders separating one cell from another.

To apply table borders, users need to:
· Select the border style, border width, and border color.
· Select the cells to which the border effect has to be applied.

· Click the Borders button and choose an option from the drop-down list.

	Additional Notes:

You can also use the Format Table dialog box to change borders and fill formatting. Choose Table from the Format menu to open the Format Table dialog box. Alternatively, right-click selected table cells and choose Borders and Fill from the shortcut menu.
Teaching Tip:
Discuss the Format Table dialog box as an alternative way to apply cell borders and fills.
Text Figure: F13-14


[image: image8.emf]Remove a Fill Effect  from a Cell


Text Figures: F13-15, F13-16, F13-17


	Section 13.6

Inserting a Microsoft Word Table
PowerPoint offers a variety of features that enable users to create interesting and attractive tables. Word tables, however, make some of these features more convenient to use and offer additional features as well.
A user can create an advanced table in Word and then copy and paste it onto a PowerPoint slide by using the Paste Special command on the Edit menu. 

Inserting a Word Table
The Paste Special command on the Edit menu is used to preserve all of Word’s formatting when a table is copied. This feature links the Word table in PowerPoint.
Making Changes to a Word Table
To make changes to text, numbers, or other formatting in a linked Word table, users need to double-click it to open Word from within PowerPoint. All the Word table tools will be available to work with.

	Additional Notes:
If you use the Paste button or the Paste command to copy a table from Word, the table will be converted into a PowerPoint table and lose any special Word effects that are not supported by PowerPoint.

Text Figure: F13-18

Teaching Tip:

Inform students that if they do not see Microsoft Office Word Document Object in the As: list box, they should click Cancel, click the slide and then try again.
Text Figure: F13-19

[image: image9.emf]Make Changes to a  Word Table
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